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1. STS8200 5 VC2005 L&5Ehk /e, 5 tEfe/F 1 &2~ “window.h 7, “usertype.h ”
RE5

(1) F7FF VC2005 J5ik#f Tools->Options

File Edit View Project Build Debug.Tools Window Community Help

@ -EEda R - 5 Attach to Process... Ctrl+Alt+P

L Connect to Database...

Solution Explorer - .. » 1 X E Code Snippets Manager...  Ctrl+K, Ctrl+B

B
[ Solution 'FOVI_Example' (1
[ (54 FOVI_Example

Choose Toolbox Items...

ILDasm
Visual Studio 2005 Command Prompt
External Tools...
Import and Export Settings...

Customize...

Options...

(2) fE Options->Projects and Solutions->VC++ Directories 45 {ll] T 4 3% HLik %

Include files

Options )

- Environment » | Platform: Show directories for:

-~ General (Win32 3 Uncludefles v

- AutoRecover s
Documerts @ﬂﬁi—-—-
~Find and Replace C:\AccoTest\STSB200CROSS_a\INCLUDE Reference files

--Fonts and Colors C:\Program Files\IVI Foundation\WVISA\W Library files
[ Help C\AccoTest\STSB200CROSSYINCLUDE | Source files
C\AccaTest\STS8200 Rel \INCLUDE Exclude directories

- Import and Export Settings
DASTS2200_Release\INCLUDE

C\Program Files\Microsoft Platform SDK for Windows Server 2003 R2\Incl
Keyboard C:\Program Files\Microsoft Visual Studio 8\WChinclude

- Startup

- Task List

--\Web Browser

- International Settings £

= Projects and Solutions

- General < m ] [x
~Build anld Run . ~ | |Include Directories
~VC++ Directories Path to use when searching for include files while building a VC++ -
- VC++ Project Settings project. Corresponds to environment variable INCLUDE.

- Text Editor = ad

(3) ¥ include files, VC++, SDK, STS8200 ] include 332, BRIAMIH
(G IVSE
C:\Program Files\Microsoft Visual Studio 8\VC\include
(# PC N 64 i R4, VC 22 AFERINERAEAE C:\Program Files(x86)\
Microsoft Visual Studio 8\\VC\include)
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C:\Program Files\Microsoft Platform SDK for Windows Server 2003
R2\Include
C:\AccoTest\STS8200CROSS\INCLUDE
(4) ¥ library files, VC++, SDK, STS8200 ff] LIB -3, BRINHIEEIE
T3
C:\Program Files\Microsoft Visual Studio 8\\VVC\lib
(# PC N 64 fi 5%, VC R AFERINERIEAE C:\Program Files(x86)\Microsoft
Visual Studio 8\VC\include)
C:\Program Files\Microsoft Platform SDK for Windows Server 2003 R2\Lib
C:\AccoTest\STS8200CROSS\LIB

2. fEMAINVC2005 LLRENVS2013 Af, 7 debug L EEFEHFET, BrEAEH Alt+F10
(Apply Code Changes Z/55)

(1) f§i[ VC2005 ivf, H“fEFF&HE&H “07 B, AIREZF2 Apply code
Change Joi£A$ 5

(2) f#if VvS2013 i, FTFF T EA~ Tools-> Options #£3, £ Edit and
Continue Difg, %A E A ek & ;
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Options

Search Options (Ctrl+E)

b Environment

i Projects and Solutions
b Source Control

b Text Editor

4 Debugging

ral
I Edit and Continue I

b F# Tools

b Package

s

(3) 1L EF: Project-> Project Name Properties T,

TasT-Th-Time
Qutput Window
Symbols
b Performance Tools
b Database Tools

b HTML Designer
i Office Tools

Manager

b SQL Server Tools

b Text Templating

b Web Performance Test Tools
i Windows Forms Designer

b Workflow Designer

, Editand Continue
[+ Enable Edit and Continue

Mative-only options
Enable native Edit and Continue
Invoked by debug commands

Ask first
Warn about stale code
Relink code changes after debugging
["] Allow precompiling

[]Enable while debugging an application running under another user
account
Enabling native Edit and Continue disables data viewing
H enhancements in the debugger. Edit and Continue is not enabled
for C++ in Windows Store apps.

Cancel

VA S L T WAIID I TUIT i SO 2 S

Efi7s:  ISAFESEH:NO
FOVI_Example Property Pages 7 s
Configuration:  Active(Debug) ~  Platform:  Active(Win32) v Configuration Manager...
b C/C++ ~ Al Options
“ Linker JOUT:".\FOVI_Example.dll* /MANIFEST /NXCOMPAT /PDB:"\Debug
General \FOVI_Example.pdb” /DYNAMICBASE “odbc32.lib" "odbcep32.lib® "UserRes.lib®
Input “UserType.lib® "kernel32.lib" "user32.lib® "gdi32.lib" "winspool.lib® *comdig32.lib*
Manifest File “advapi32.lib® "shell32.lib" "ole32.lib" “oleaut32.lib” “uuid.lib® /IMPLIB:" \Debug
Debugging \FOVI_Examplelib® /DEBUG /DLL /MACHIMNE:X86 /SAFESEH /INCREMENTAL
System /PGD:"./FOVI_Example.pgd” /MANIFESTUAC: level="asInvoker’ uiAccess="false"
Optimization /ManifestFile:*.\debug\FOVI_Example.dilintermediate.manifest”
Embedded IDL /ERRORREPORT:PROMPT /NOLOGO /LIBPATH:"C:\AccoTEST\STS8200CROSS\IB®
. I JLIBPATH:"C:\AccoTEST\STS8200CROSSMNCLude ™ /TLBID:1
Windows Metadata
Advanced
All Options

T TUaLE YUY

Command Line

> Manifest Tool

[ XML Document Generat
I Browse Information

I Build Events

[ Custom Build Step

- Code Analysis

Inherit from parent or project defaults [_|

Additional Options

/SAFESEH:NO

il REFE(A)
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3. & VC2005 B¢ VS2013 #E17 debug Af, HEBF AR TEE T EB A

(1) w5 A 7R Source Code AULHL, 1 T H A~ Tools->Options i£1i, X%

Requires source files to exactly match the original version, 2<#5iZi%T.
. Options @@e

- Environment General

(- Projects and Solutions
(- Text Editor
(- Database Tools

[¥] Ask before deleting all breakpoints A
[¥] Break all processes when one process breaks ,
] i [7] Break when exceptions cross AppDomain or managed/native boun
p¥-Debogaing [¥] Enable address-level debugging

[] Show disassembly if source is not available
[¥] Enable breakpoint filters

[7] Enable Just My Code (Managed only)

E -Edit and Continue
B Native
- Symbols

n

Warn if no user code on launch

(- Windows Forms Designer .
[¥] Enable property evaluation and other implicit function calls

i [¥] Call ToString() on objects in variables windows (C# only)

|| _Highlight entire source line for breakpoints and current statement
[7] Require source files to exactly match the original version

] Redirect all Output Window text to the Immediate Window

H [T] Show raw structure of objects in variables windows Ls
[V] Suppress JIT optimization on module load (Managed only)

4| n TR R | »

[ o H Cancel ]

(2) T35 2R 8200/8300 #AHTHF, N4 HBLTCIES AW s LS o
(3) £ VC Wi, 1EFF debug #E3X, release BLxToiZidt AW i,

Dd Floating_Source Tutorial FOVI - Microsoft Visual Studio
FILE EDIT VIEW APA PROJECT BUILD DEBUG TEAM TOOLS TEST ANALYZE WINDOW  HELP
A | = %= | n s s Q- | B2 W wl © v| P Local Windows Debugger ~

testepp & X

Debug

= Release
@ InitBeforeTe

Configuration Manager...

(Global Scope) -
#include "stdafx.h"

(4) B THRABEANIE, SEGFEN dI SCHHE R 22 B4, &L
WERE O TAEH . BUEAE VC i, 4 TFE4, sidh Properties (&
PE) -, ¥4 Output file J5 T 1 dll S 42 56 35 A 56 25U A4 0%
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Dq Floating_Source_Tutorial FOVI - Microsoft Visual Studio
FILE EDIT VIEW APA PROJECT BUILD DEBUG TEAM TOOLS TEST ANALYZE WINDOW  HELP

| | L) siie- | B~ w hh| - '| P Local Windows Debugger ~

—
g, Solution Explorer v X
o - -
g @l o-2d@| # =4 hio
g Search Solution Explorer (Ctrl+;) Rebuild
£ orja Clean
S 5
= orial FOVI| [ERVINN N
] External Dependencies
o L] p
5 N Anal >
% 4 Header Files na. yze
= 4 Resource Files Project Only 4
4 .. Source Files Scope to This
’ Floating Source Tutorial B New Solution Explorer View
++ StdAfx.cpp
P *++ testcpp Profile Guided Optimization 3
B ReadMe.txt Build Dependencies 3
Add »
g Class Wizard... Ctrl+Shift+X
# Manage NuGet Packages...
£# Setas StartUp Project
Debug 3
Source Control 3
# Cut Ctrl+X
Gl Paste Ctrl+V
X Remove Del
¥ Rename F2 */
*/
Unload Project y
Rescan Solution
Output Find Symbol Results Find Re: Open Folder in File Explorer
This item does not support previewing alioneie
| Floating Source_Tutorial FOVI Property Pages
Configuration:  Active(Debug) ~  Platform:  Active(Win32) v
General ~ | T . Fioting Source Tutorial FOVIdI]
Debugging Show Progress Not Set
VC++ Directories Version
b C/C++ Enable Incremental Linking Yes (/INCREMENTAL)
Suppress Startup Banner Yes (/NOLOGO)
Ignore Import Library No
Input Register Output No
Manifest File Per-user Redirection No
Debugging Additional Library Directories C\AccoTest\STS8200CROSS\IIB: % (AdditionalLibraryDirectories)
System Link Library Dependencies Yes
Optimization Use Library Dependency Inputs No
Embedded IDL Link Status
Windows Metadata Prevent DIl Binding
Advanced Treat Linker Warning As Errors
All Options Force File Output
Command Line Create Hot Patchable Image
b Manifest Tool Specify Section Attributes
b XML Document Generat
> Browse Information
I> Build Events
. =
b é.u;to:\ BT”(.‘ S Output File
et ~ | | The fOUT option overrides the default name and location of the program that the linker creates.
< >

(5) VR ARTFHAE, U 360 R,
4. STS8200 B¢ STS8300 HAELEST —BHT 5 T B HBEFE1F IR &

(1) STS8200 A4 M 191011 _r p3.1 JF4f, STS8300 A A 200814 _r ATt

G, XFF Offline B fF 75 Z2AN N license BIE, 1 IR —AH 7%k
W, BN AR IR A, TS TEIE R AccoTEST £ 8//
%, HIE OGRS ;
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(2) &g R Offline B fF, w4R: =g MK FHHA license SCfF
PSS FIGE AN E WIFI B 7] 58 S 20 MAC 37484k, 52X license
SR, D) [ S S0 I 1Y) WIFL B 5T H 3R licenses

(3) X7 Online RA, #fF2HZLRM PCIPCle &, #iBE5RH, B
PCI/PCle R 54, WA AESEURAFRANEIE RN, SERT @I 7E R & AR
K PCI/PCle 42 IR BRB 2 75 I 22258 BT 5[5 PCI/PCle - B il iz ;
He #2752 PCI/PCle KHidk;

5. [F—&Bp k&3 STS8200 A7 STS8300 5, H AL IE## TR — K 2N
A ? WIHTEEF A2 [T ] 2
HR—: FohdE
(1) 5 %c2¢%% STS8200 (‘22245 33y STS8200CROSS) i 2% STS8300 (%%
AF Iy AccoTEST System), W BEIE 5 F1HF Al H STS8300 kA, 75 M2 A

RS

contral b4

Please launch from CA\ACCOTESTVACCOTEST SYSTEM

(2) A B[R] STS8200 #A4-f8 F -

JESCEJE: AccoTEST System 1&2#%: AccoTEST System 8300 (At 42 5)
JE S f5%: STS8200CROSS 1&E4/ii: AccoTEST System (ASAJ &Mk HiAth)
BP AT+ I-487 FH STS8200 A4+

(3) #2a%%e STS8300 #ifl, Fizede STS8200 #fl, FPIHk[al STS8300 #k
G

JE S f5%2: STS8200CROSS &% /k: STS8200CROSS 8200 (mRH:Ah4 )
JESCEJE: AccoTEST System f&HU#: STS8200CROSS (ANAJ & 2 i HiAih )
R f#iH AccoTools T E A7) #
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#* Acco_Tools = X
BackUp Cul+B EI_

DataLog Ctrl+D

STS8300 2.1.0.0.200814_r_p3.1

1.1.0.0.220419 rp2 0
STS8200 1.1.00.220419 rp3 0

8300 Softvare Version List

STS8200 1.0.3.0.191011 _rp2.0 STS8300 2.1.0.0.200814 r_p3.1
STS8200 1.0.3.0.191011_rp3.1 STS8300 2.1.0.0.200814 r_p4.0
STS8200 1.0.3.0.191011_r p4.0 STS8300 1.0.0.0.181219 r1.5
STS8200 1.0.3.0.191011 1 p1.0 STS8300 2.1.0.0.200530_b
STS8200 1.1.0.0.220419 rp1.0 STS8300 2.1.0.0.200814 f
STS8200 1.1.0.0.220419 r p2.0 STS8300 2.1.0.0.200814 r p5.0
STSB203 1.1.0.0.220419 r p2.0 STS8300 2.1.0.0.200814 1 p2.2

Wi -

(D) [ [ AT B R 2R AN, 50 SE) RN
(2) BB B Rn B RIS T T3S BLFI AT, DI o< I A AR QR A, Bl
TestUl. PGS. VS 4,

(3) YAT% LRES TRARA T HE& 0 A s L. ARk
Deglitch % £k Gage & 5 Thag, TEEEEN:
http://gofile.me/3HgJo/bboAxulYe

25704 accotest
6. @ VS2013 Af, A E APA ZEEA T

(1) %% VS2013 J AccoTEST #AFI, k224 VS2013, Fiaede
AcCOTEST #fF, HMIATAE FE APA T ETILIEMI %3, 2% AccoTEST #tk
I, SeCH] VS2013;

(2) SdIFEASEH, k3 AccoTestSTS8200CROSS ¥ AccoTEST System
i, SR Install VS2013 Tools SCHF
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B AccoTEST System
8 Control

Ll DataAnalyse

B AccoTestSTS8200CROSS

%% Control

DataAnalyse ICH Debug Tools

Debug Tools B nstall VS2013 Tools

B install VS2022 Tools

B8 install VS2013 Tools
Il Uninstall AccoTEST System

<= .
s Uninstall AccoTest STS8200CROSS Bl AccoTESTSTS8200CROSS
A~ Adobe Acrobat DC J~ Adobe Acrobat

16 . . Altium Designer
2J'¢ Altium Designer

L O 5 M M

(3) 7E3#H Install VS2013 Tools & 1 < H 3hiE47 %238 VS2013 #ifh, 7Bk
223t VS2013 5ERR” B, A DART AR iz w0, P DAIA— T
APA BT O w3t

B Install V52013 Tools — O X

(4) B ARIEZIRIF %%, 7T PAFRE] AccoTEST #ith222% H ik NI
VS2013ToolsSetup.bat, LLE EEJ\%{ 1217, HEHrede APA TH;

V52013 ToolsSetup.bat

Common7 4 IDEY”

(5) 2Vl BT 3] APA, BHE T H A~ TOOLS T A Extensions and
Updates, iy APA 45l Enable $Z%HffifE APA T H, A5 5 VS2013.

www.accotest.com
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b FOVI_Example - Microsoft Visual Studio 0 ¥  QuickLaunch (Ctrl+Q) P - B X
FILE EDIT VIEW PROJECT BUILD DEBUG TEAM | TOOLS | TEST ANALYZE WINDOW HELP ¢ yinjiao Tao ~

i @| & Attach to Process.. Cri+Alt+P = - |Debug - | M oiwm s = | : | S_g| n:
R *¥ Connect to Database...

%8 Connect to Server... = N
@¥ Add SharePoint Connection... Hafx h" =
g SQL Server » th.h" -
- " NuM 2 —
= &' Code Snippets Manager... Ctri+K, Ctrl+B
;;_ Choose Toolbox Items... 3
= Add-in Manager... "
beaoc Packagoe Mo v ko
H
l; _ Extensions and Updates... -
Create GUID eeeees—— »
Extensions and Updates ? X
4 Installed Sort by: | Name: Ascending - Search Installed (Ctrl+E) P~
Al B3 aPA [ Disable [ created by: AccoresT
Controls AccoTEST Business Unit of Beijing Huafeng Test & Date Installed: 2021/11/19
Samples Control Technology Co,Ltd. Al Rights Reserved. [ uninstatl 1~ CC 0
Templates Behaviors SDK (XAML) More Information
SDKs Q The Behaviors SDK (XAML) enables you to add interactivity to your Getting Started
Tools Windows Store applications without having to write any code.
b Online 6 Microsoft Advertising pubCenter Service for Visual St...
This service allows you to use Visual Studio to access features
b Updates (8) g 4 o5
provided by your Microsoft Advertising pubCenter account. You c...

7. EF Windows R4, TEAM, HAEEEF

(1) #H2% Windows R4i, 75 HHT 2485 R IRsh;
(2) T ER A, sl e, BRI PCHR DR, AR
Fidy, EFE CHEHORBREF AT

g_t)l,u; » SHER » ZHESE » B8
-~ —=_— s

BRI
& pueEE | W = [

() EREES|_ || e mtew) sEM) _SEH)
& mERs . =
@ S A--é TESTERL

& SRzEERE b DVDACD-ROM I

-4 IDE ATAFATAPI 525158

- e

[0 4HEER

by EEEE

-3 =it

» 95 &0 oM 3len

b8 HERL

J T Emaesnee. |

b ANETFBAE =i

| EE TR FEO

o[} miRIRtEsaE SRR
b EEECLERNE

b EEEES BHE®

b A

By EriE

(3) E# “W AL LA E SR IKBIRE B AT
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(4) IEPRNFEF B4R, BRIAN C:\AccoTEST\STS8200CROSS\DRIVER (81

& emems

P

Sihadbi wEILY:

PR essF

BEA) FEV) #EHH)

>

SIS FIRAREFIRIF?

B REHABKAHEFIAF(S)

Windows SESHITEN Internet L ERFTIEXSENSFENETR

# | B rERERRaRrERLRe.

3>

W BHASERIREIEFIRF(R)
FNERHEBTIRERM,

-

=2 e

fih 22242 T DRIVER SCAFR), ik “UR2 238 sUUKENRE P At

& U mmmamsse - co mEEREYE

| swsitssn cenesmem
|
| EuToBesEuRTse:
| :
| Des=eR0 (e =
| AR OSSR IR
| J. CheckData
| > NitEnaiRE] ) clbdata
| mi_# )i clresult EN
| = . Ji DATALOG
: J. DebugTool
{ 4 |. DRIVER
J. HANDLER
L PCl i
o
|| %k DRIVER
3

2 5 emenn

TR BfEA) BBV =EH)

e

L Yo =N o R ST
4 TESTI

b3 0 () I SRR - PO BSEREEE

bcg I
-

I AR ..

(BB 0 ¥ Windows 222

= ® Windows I iTiIRZ BT

> TEREHIREFIIEN)

F WAL ARSI AR

BRERTEASEREE.

(v) EEREEED)

-

(5) ‘I INE, 27 HFTC Sts Series Device | &4 il B4 1R

www.accotest.com
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| RPN = (& eamma © A——
XA BEA) BBV EEHH |
€m0 B 6 E NS S EMER) BB EEH)
4 & TESTERL e mEIAmE
< DVD/CD-ROM Bansk 4B TESTERL
. IDE ATA/ATAP] 2%1E8 < DVD/CD-ROM st
L d [ 4 &) HFTC Sts Series Device
| ¥ S£:8000 handler Interface Board
i & Sts8000 PCI Interface Board

i IDE ATA/ATAPI Fe3i28
Windows EEmhitEsmRahieRs ‘ o EseE

@
8]

j () L BFEDRERS - 558000 PCl Interface Board

o (@ Em
g ERENE
by
BGH  Sts8000 PCl Interface Board ¥ &0 (cOM F LPT)
< b8 R
Lo
] 2
\ U5 AtEEmARE
pow =, TR
P sfEeEtae
§ EERToEENE
b RS
T EHEE
N, SrEms

Windows B2seaisesitid StiieFnet:

8. VC2005 1&/H debug ZJEEL~E )Y TestUL, B Hz)H1# PGS X 1F

(L) BT HAE Project -> TFE X% @ M:/Property it B U1, i NKE, {E
Command #, % IEHI testui.exe FIEE 1R

(2) {£ Command Arguments HIENIEHHT] PGS 42 , FEEIRE “-
AutoLoad” FFf

084 Property Pages ? ®
Configuration: | Active(Debug) ~ Platform:  Active(Win32) v Configuration Manager...
» Common Properties Debugger to launch:
4 Configuration Properties el e S L .
General
Debugging
VC++ Directories Command C:\AccoTest\STSB200CROSS \testui.exe
b C/C++ Command Arguments -Autoload "C:\AccoTest\STS8200CROSS_P9.1\TESTFILE\LT1084\LT1084 FT.pgs”
b Linker L4 L S 14 ) [ 121 )
I Manifest Tool Attach No
> XML Document Generator Debugger Type Auto
I Browse Information Environment
b Build Events Merge Environment Yes
b Custom Build Step SQL Debugging No
I Code Analysis Amp Default Accelerator WARP software accelerator
Command Arguments

The command line arguments to pass to the application.

A HAW
9. ZAWindow? £Z F, AccoTEST HALE1E 5 Lt LB 7 K575

(1) BEAFESIH, 2] [X 18575 7 Ichange display language

www.accotest.com 14
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Adjust your computer’s settings

Viewby: Category ¥

@iy  System and Security : User Accounts and Family Safety
Review your computer's status 'fj’ Add or remove user accounts

Back up your computer
Find and fix problems

rﬁ' Set up parental controls for any user

Appearance and Personalization

Network and Internet w Change the theme
t. View network status and tasks ) Change desktop background
- Choose homegroup and sharing options Adjust screen resolution
y Hardware and Sound Clock, Language, and Region
> View devices and printers ‘ 1_ Change keyboards or other input methods
Add a device /

Connect to a projector

| Change display language |

Let Windows suggest settings

Adjust commonly used mobility settings k@ Ease of Access

~ Programs
h 41| Uninstall a program

Optimize visual display

(2) 78 “#B/Administrative” -> “ T R 4t [X 45 1% B /Change system

locale...” HHXUE S LI,

——
e W —

9 Region and Language

Welcome screen and new user accounts

accounts and new user accounts.

Tell me more about these accounts

Language for non-Unicode programs

Chinese (Simplified, PRC)

View and copy your international settings to the welcome screen, system

This setting (system locale) controls the language used when displaying
text in programs that do not support Unicode.

Current language for non-Unicode programs:

| Fomats | Location | Keyboards and Languages | Administrative

[ @ Copy settings... ]

[ @' Change system locale...

What is system locale?

(3) FEZHAI ARG XL B BN R ags s (fk, FED

/Chinese(Simplified, PRC)”

www.accotest.com
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9 Region and Language Settings S

Select which language (system locale) to use when displaying text in programs
that do not support Unicode. This setting affects all user accounts on the
computer.

Current system locale:

Chinese (Simplified, PRC) | v] M

[ (0].¢ ] [ Cancel ]

(4 Beser)a, SeEPE, EEASRERE, H=Hzdk.

10. ZWin7 BZ T, REFZHAESER H14#5 “ Exception EOleException in module
Datalog.dll at 000802A2 *

B0 PRAFEE SCPF 2R H 3% D\, BUEESCARI A, 10 it SR A i 2
d:\data\ry, JUANZ HE A

Iz TS
Application Error

fERITIE: B win? REE N HETHT 2B, R R BEE R, AR5
R EIER G

www.accotest.com 16
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(& mewsmweE (=@ = )
PERANENER T B EXRE
Brtreslan TR aSRFSait BETER.

EFXEARASEEEMREES

SR

i e A - QEEEsENEATH SIS TR

® ZEX Windows BEFHTRNINIARBR
= [
O nscsEmsNRFMSERIMES  WESETE

| s Em,

WAER
ias

11 ZEREBREZGT (WIinT LLEFFRS) , /50 Control #f, St& “BAEL

R BRI KA BT TR/ T o BTG ”

2FE™: control.exe
EHE: &
R HATEN R aa

(v) BFeEEE0) [ 2w [ &~ ]

TESTUI N -

Control.exe is not launched, please launch Control.exe.

SECCE R B R, R R BE PR, AR E R R RS

www.accotest.com
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"% mrersmeE o8] ®
|

SR ARHERE X B EXAYER

\ BN AR TR AR RN G SR,
‘ EXES KRB EES

TSt
|
‘ = Es HAM T ERRRSFEBaE:
¢ EFTERSREnENEANTE,
& | o= * FENT Windows 28
O Fexm QEZBEBEFE Windows 7 MENE
FE, TREBHET | RORwEsATEaRKs
o =al.
MWREA

() )

[

12. XE s Ul B/F, 18550 TestUl g2 E R, #RU T #5+ “Control.exe

is not launched, please launch Control.exe...”

TESTUI X [

Control.exe is not launched, please launch Control.exe.
CA\ACCOTEST2021\STS8200CROSSP3.1\ |

Bzt Ul ik “ VS G S fnisdr bl 7, ZExzatt, Bshik Ul Zhagtk
HIEH

www.accotest.com
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¥ TestinterfaceWin.exe Bt X

N WAL 2o EEES MRS
RIS RER M) Windows LIERTIEF, WeEamive:

| FeEl
[ pgsstini TR e
Windows 8

RE
(] rfeavpmiatest
8 {i2(256)8

[ FB 640 x 480 RS R=ES
Clzmemiik

| DuEmRsmiEmiEs N
ClsEmmitierrlEsnEa

XS DPI i E
S ENFERrNEE

HE LUFE] REE(A)

13. Excel2007 385 FHEH i/ £ 5 Excel AfH#E, BEHER “TETHE
WM

& Microsoft Office Excel = P

I[-'-T‘:.-' Microsoft Office Excel 2L T4E ( Dataanalyse g

Windows S]LAEE FARNSAEESZEASRESE | FElREENE
=]

e

> REBMGEERSE Q. FRIEAEEY, .
> TS B
*> BE{iER

(v) =EREEE=n

J7ik L MR TR e “ARNT R B A R DCHIE AR R AR
Jiik 2:
(1) #TH EXCEL, # Ni&Li:

www.accotest.com 19
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|%#| #=E® » 9 90D-2A11N3-60-----2017-12-1.xIs
D2A050D00---2017-12-5.xls

@ BEZD relay.xls

20171020-zjq_yxls

D 2N iR GERA B
1 JMC-069-EriE.xls = || | E e
L} Q) 2 111xs = E‘ EHanEEs
3 PCBIII=Kxs = -
H FFO 4 JZX-10Mxls =
‘i s > 5 SAPIEF=RIEES=-82035-180131.xlsx = T D> |
6 MESHEFDHE xlsx =
@ FTE(P) , 1 MESESZExsx =
8 2914GW.xls =
=
=
+a
=

|gbdﬁ@ [X B Excel0) |

T e
(2) ®E a7, SFENTHRE, HUH2)iE FoxitRead ... Add In, s
5E 5

Excel B

i ) SRR Microsoft Offce SO '

28

Lo IR

i E4:3 oF e -

[ ERDEBERNEE

asw Chinese Translation Addin C:\...fice\Office12\ADDINS\TCSCCONV.DLL  COM 103l
FoxitReader PDF Creator COM Add-in C:\..ins\Creator\x86\FPC_ExcelAddin x86.dll  COM #nE&R
Office Special Symbol Input Add-in Ci\...Office\Office12\ADDINS\SYMINPUT.DLL  COM 0@

EEFO b

i HEDEARENES
Internet Assistant VBA Ci\...oft Office\Office12\Librar\HTMLXLAM  Excel ho85% :
EEIRRS C:\..ice12\Library\Label Print\labelprintxdam Excel H0SEM
FENme C:\..\Microsoft Office\Office12\OFFRHD.DLL SCEieEss
AmS lookup.xlam Excel SOSOR

\ SRIAS analys32.dl Excel SOEE

SHLERE - VBA atpvbaenxdam Excel hoEER
SRR solverxlam Excel $08R |
BSTIR eurotool.xlam Excel ARSEM l
A& (Outlook BBFEHIEA) Ci\icrosoft shared! Tag\F DL a3
\E= (EenEEE) Ci\..microsoft shared\Smart Tag\MOFLDLL  E8A%2 -

: Chinese Translation Addin
: Microsoft Corporation

C:\Program Files\Microsoft Office\Office12\ADDINS\TCSCCONV.DLL

COM addin that translates between Traditional Chinese and Simplified Chinese.

COM ANEEIR

B HIFIR @)
+/|Chinese Translati .
= eader PIF C M Add-in
/|0ffice Special Symbol Input Add-in Lo

-

a8 C:\Program Files\Foxit Software\Foxit
TNEATA:  BEhEHNEE

Reader'\plugins\Creator\z88\FPC_ExcelAddin_x86. d11

www.accotest.com
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14. Excel2013, Excel2016 HEF T, HH A BrEa AR mdo XAEFE#: Excel Hi4,
FBaN “HEIFIY T 75 25 BEY iR 7

| Dataanalys; y A &‘

8 EIEIS ISR, |

@
Al HE T Excel RIS, BUEE, BEEST AR IE R #H It E excel FidE

A

15. Excel2013, Excel2016 35 F, HEPITE/EAEEM I mdd HEEAFE
25 Excel A, BiHHT Excel XHEREGHET

Al RE T Excel R, BGfE, FdE MR W It excel 2idE

A

16. Excel2013, Excel2016 Z5F FH#E S fFE# Excel FEE1E

HEERGRE 64 A WINT7, 123 32 A1) Excel 2016 , fE¥%# Excel i

e, IR K.

itk J7 % #1332 7 Excel 2016, FEHrZcd: 64 f7ff) Excel 2016, ¥i%/)5,

FIF B A A, B a] i e 1)

www.accotest.com
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17. Excel2016 Z5F FHEAITEFEHe Excel HIHEER?

i ystem Data Analysis D:\Daily\a350\2200\T

File View Tools Option Source
= & g =] i
Open Print TXT Excel Csv STOF

0112495_1_FT3_20201221161513.mdb\TS20112495 1 _FT3 2020122116
= Q ® =] T
Statistics | Mapping Excels CSvs STOFs

513.mdb

O P Y

Summary | Data | Statistics | Charts |

STS8208 StationA
Date:2020-12-26

Tester ID:STS828BEX-88
User:D8

Handler: ghandler.cfg
Site: All Sites

Lot 1d:TS20112495_1_FT3
Device ID:1

OPERATOR ID:1

Average Test Time(ms): 3872

Idle Time: 1 day 8:51:13

Beginning Time: 2828-12-21 16:15:16
Ending Time: 2020-12-26 8:u44:07
Total Testing Time: 3 day 7:37:37

Total: 295878
Pass: 285526 96.50%
Fail: 16344 3.56%

sBin[1] Pass_ Default 285526
SBin[5]  open u67
SBin[6]  short 21
SBin[7]  Keluin 2189
sSBin[8] P_open []

96.50%
0.16%
0.03%
0.71%
0.00%

[CRCRC U

Program:C:\AccoTest\STS820BCROSS\Download\StationA\JWS093_E_SOT563_BAF_0.3\JU5093_E_SOT563_B4F_0.3.pgs

| R, TS SERREEAT
T

k

1 PC S22 251 Excel 2016, #RJ5 %% WPS. WPS 248 Excel [f)—LbLI)fess
=, SEUEM RN, RIS Z3EM WPS 2% Excel 1) VBA Z5I)R8i%
Wi, FREICEIEL WPS, PR TR,

18. warning MSB8012 Z7AT#F

(R @WEO)E e T

ffyix BBl

rFOViEumple Property Pages B
Configuration: | Active(Debug) v | Platform: [Active(Win32) v) [ Configuration Manager... |
| b Common Properties 4 =] +

4 Configuration Properties Intermediate Directory \debug\
1 General Target Name $(ProjectName)
Debugging Target Extension il
VC++ Directories Extensions to Delete on Clean *.cdf;*.cache;”.obj; ".ilk; " .resources; " tib;* tii; " tlh;*.tmp;"
b C/Ces Build Log File $(IntDir)$(MSBuildProjectName).log
b iokes Platform Toolset Visual Studio 2013 (v120) s
b Menifest Tool ‘ Enable Managed Incremental Build No
b )B(ML Dolcl.'lment Qeneutor: 4 Project Defaults
: B::I:I:s:v:n::ma(mn Configuration Type Dynamic i.bv:vy (,.A;.) _
p Custom Build Step Uve of MPC Use 3t b .
b Code Analysis Character Set Use Multi-Byte Character Set
Common Language Runtime Suppor No Common Language Runtime Support =
A b Db . Nl o o e o
Output Directory
Specifies a relative path to the output file directory; can include environment variables.
« m ’ j
| 0K ' [ Cancel ] Apply
Q— —— —— —— ————— — _ —
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19. HAEE  “BEfER B %45 Hardware Configuration check Fail ”

|
I
|
I Q' Hardware configuration check failed!
|
|
)
I

_ a= |

(1) a7 TestUl -> Options /&7 3 Enable Hardware Configuration Check,
A e 26k 24w AL I BEC B AR 37 5 HardwareCfg () iR 250 1 C B i1 T4
A, AYRTIAR LA RS E DT HardwareCfg() IR B, Tl <x4fdl . 2 H 2
BB, PR IR TG -

Test Control } Save ]View ] Handler] Hotkey] Sound} QA ] Other]
Stes Control

vl Site1 v Stop on Fail

¥ Enable Alarm

[~ Stop after Auto Test 0 :I

[~ Stop after continuous failures of each site up to 0 :I

[~ Stop once lastest 100 yield of each site s lower than |50 Ya

[~ Stop once vield difference between each site is larger than =0 %,
100 r

v Enable Log

C |

I ™ Enable hardware configuration check I
r~ =
Alt + A) ,7
T T [~ Stop after continuous pass of each site up to 0 :I

I~ Calculate the ratio of the certified products

Enable All | Disable Al [~ Stop after exceed Statistical Bin Limit, minimum samples 1oo
Enable Selected r g
Disable Selected [~ Stop After exceed Statistical Parameter Limit I=
Invert Selection

Save Options for | Save Options To LDF ok | Cancel

i

¥ HardwareCfg() H AR MM AIEC &, Online JRZS N, #AF AT RE R4 .
¥+ Options #1fii Enable hardware configuration check 1235 2K (AN A &8 2 -
T AR 7 A A2 75 it ) J B B R 7 ) B8 ST SSetHardwareCheck(); 8300
B AERRAS 200814pra.0 K LSS RIRAS, PGS hiiAs 1004 & LA 1, x5l %2

e, H R G R P DR E 12 Dh AR FH R A .

=

i
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(2) STS8300 i FHMAAE P kAT 2 Wi & H L LA B3R, &5/ 1E Control
YU, System Option FHAfiiA & A FEI, #7 2 /a) ik ik 24,

Option X
[General |
System Setting

Open Project With
« vece (& Later versions of V52005

Reload the Test Program Before Contnue Testing
[ After Power On [V After InterLock Check Fal

[~ After the tester runs Check, Calbration or Dagnoss

Log Path: |E-\ACCOTest\STS8200CROSS\ =

Password for Authorty alarm elmination: I

I~ Disable Al Test Control On RT Test

RT Test Mark
- $ ’ c
User Control Setting
B Forbidding Test on Check Fai
Calbration Option
Calbration Period(Month) |5 j
[~ Forbidding Test on Calbration Fal ¢ c

Save Options To User 0K Cancel

20. ZEERT, X IEHEIR BB “blocks nested too deeply ”

Error List
Vv | €3 1 Error | ! 0 Warnings 0 Messages Search Er
Description ~ File Line Column
€31 error C1061: compiler limit : blocks test.cpp 631 1 I

nested too deeply

AR B R B 128 MREZU RS, Wik B BIHHR L B, XHiZ
HRAFAER) function HBEAT /) BOAb . & IR E B BN 2 MR E R B G
IR R B
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—
{//add
BFint i = ©; i < SITENUM; i++)

{
¥
for (int i = @; i < SITENUM; i++)
{
1
for (int i = @; i < SITENUM; i++)
{
1
for (int i = @; i < SITENUM; i++)
{
for (int i = @; i < SITENUM; i++)
{

}//add
or (int i = @; i < SITENUM; i++)

{
¥

c P o . T

21. #FL PGSEditor SRZTHJ Code ZEEHA VC TR, WX ELE 2 FI 54
Bl ERPISERE, BAEMTH test.cpp

?LT_PI int TOS_IDTOS_IOUTDET_trim(short funcindex, LPCTSTR funclabel)

//{{AFX_STS_PARAM_PROTOTYPES
DUT_API int T09_ZCD_trim(short funcindex, LPCTSTR funclabel)
//{{AFX_STS_PARAM_PROTOTYPES
DUT_API int TLO_ILIMIT trim(short funcindex, LPCTSTR funclabel)
7 //{{AFX_STS_PARAM_PROTOTYPES
79 DUT_API int TLL_QSILIMIT_trim(short fumcindex, LPCTSTR funclabel)
//{{AFX_STS_PARAM_PROTOTYPES
DUT_API int T12_O00A_trim(short funcindex, LPCTSTR funclabel)

//{{AFX_STS_PARAM_PROTOTYPES -
DUT_API int T13_0SC_trim(short funcindex, LPCTSTR funclabel)

//{{AFX_STS_PARAM_PROTOTYPES _
88 OUTAPI int T14_EFUSEBURN (short furcindex, LPCTSTR funclabel)

A SE BT test.cpp HH A BR BB S 20010 I (M R 15 A A5 sl B, 52 B g A
WA &, I{{AFX_STS_PARAM_PROTOTYPES 3 F: /A ml &M 4 .

76 [-IDUT_API int test_Examplel(short funcindex, LPCTSTR funclabel)
71 4

72 //{{AFX_STS_PARAM_PROTOTYPES

73 CParam *Examplel = StsGetParam(funcindex, "Examplel");
74[ = //}}AFX_STS_PARAM_PROTOTYPES

75 // TODO: Add your function code here

76 return @;

77 |}

A E RO TR R AR5, T RIARE 2 H 3T TESTFILE SCFRAZ T
A DUT CFE DUT SCF N R BB, 25 CRIER Bz, g 228
BT, BONHEAR SR 23 B 3 #5 DL DUT 3CfF % TESTFILE B2 T .
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22. F/F45iERf, Code Analysis K18, 20/75¢1LH34 priysge

| Analysing Code Iﬂ

N B BR, {E VS2013 T.H A Tool->Extensions and Updates H, %] APA,
{4 APA Tt Disable, 7T LI £ FRAS A HT 28 (PinPlanner T Bith 2 ffiikf
KM BEHEFURMA APA, T LLFHEIR AT k4 APA {EfE,

ﬂ FOVI_Example - Microsoft Visual Studio [ ¥ | Quick Launch (Ctrl+Q) F = O X
FILE EDIT VIEW PROJECT BUILD DEBUG TEAM | TOOLS | TEST ANALYZE WINDOW  HELP 1 yinjiao Tao ~
. @ & Attach to Process... Ctri+Alt+P = «[Debug - ‘ A.iwm i I T % | "
PO ‘¥ Connect to Database...
™ %= Connect to Server... B .
G* Add SharePoint Connection... Hafx.h~ >
SQL Server » th.h" -
. huM 2 =
g' Code Snippets Manager.. Ctrl+K, Ctri+B
Choose Toolbox Items...
Add-in Manager.. '
» '
[ Extensions and Updates... I -
= bovsdome abmitd be daatided haas
Create GUID b
Extensions and Updates ? X
4 Installed Sort by: fName: Ascending . Search Installed (Ctrl+F)
2“ | e STl by oot
ontrols ) usiness Unit of Beijing Huafeng Test Date Installed: 2021/11/19
samples Control Technology Co. Ltd. All Rights Reserved. Version: 2.0
Templates Behaviors SDK (XAML) More Information
SDKs Q The Behaviors SDK (XAML) enables you to add interactivity to your Getting Started
Tools Windows Store applications without having to write any code.
b Online @ Microsoft Advertising pubCenter Service for Visual St...
, Und 8 This service allows you to use Visual Studio to access features
b Updates (8) provided by your Microsoft Advertising pubCenter account. You c...
- » ", v— \
23. STS8300 PinPlanner JRE, & LIS EREEIRIA, TR
[m! [STS_PinPlanner] - C:\AccoTEST\STSB200CROSS\TESTFILEVFOVIe_Example\Source\FOVle_Example O e

File Edit View Settings Help
LeBvOSE+XREBES G

Pin [ Comment |~ Resource NaoSite Sitel1] Sitel2]
1 | fovied fovieO FOVle
T foviel foviel FOVle
? fovie2 fovie2 FOVle
T fovie3 fovie3 FOVle
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PinPlanner 5 [f]f¥) slot 3244 N 255 2417 PinPlanner FL 3 FH (% 5 ASUCHEE, 4 |
Kl Frx, slotl9 ¥ FOVie & #rer. HIMLL EIS, B E#HFTIT PinPlanner
HAFL R Settings->Config File, 41 R .

(B! [STS_PinPlanner] - C\AccoTEST\STSB200CROSS\TESTFILE\FOVIe_Example\Source\FOVle_Example ] x ‘
File Edit View Settings Help
N w B Function >
Pin + Auto Modify Comment { NoSite Sitel 11 Sitel21
d 1 | fovieD SiteSetting
2 |foviel I Config File I
| 3 | fovie2 fovie2 FOVie
q 4 fovied fovie3 FOVle

CMACcoTESTVACCOTEST System backup\Confia.slot

AE slot KB REIER, W NE, AIEPNARE R, W blEl
Modify Slot Z¥ g /& 24 slot SCAF,  PREFS 4T PinPlanner it & —2L.

Caonfig File >

I C:\Acco TEST\Acco TEST System_backup\Config.slot I

Modfiy Slot

OK Cancel

24, FBSFAENS2013 _LEEIEE 48, FINVC2005 L4947 AT

Qutput

Show output from: Build - g}
TSte e S = ZSEE == = SN
1>c1 \tester\production\857\xp2115_01-aa_gd_t401\prog - Bl& \source\test. h(479) : warning C4996: ’sprintf’ was declared deprecated

ei\progran files (e86)\mieroseft vizusl studis Slvelineludelstdio h(3M5) © ses declaration of “sprintf
1> Message: ‘This function or variable may be unsafe Consider nsing sprintf_s instead. To dissble deprecation, use _CRT_SECURE_ND_DEPRECATE. See online help for details.’
13d: \tester \production\857 \xp2115_01-aa_qd_t401'prog — Bl#\seurce'test h(480) : warning C4996: * fopen' was declared deprecated
> ¢ \program files (cB6)microsoft visual studio Biwelincludelstdio h(234) | ses declaration of *fopen’
1> Jﬁasssgs ‘This function or varisble may bs unsafs

Consider using fopsn s

_CRT_SECURE_NO_DEPRECATE. See online help for detsils.’

instead To disable deprecation, use

{

ester\prvduchon\BS’?\vall o oerror (2143 symtax erwror | missing ;  befere ' |

l>d \tester\production\857\xpZ!15_01-aa_gd_t401\prog - h(SBlJ : error (2143 syntax error : missing ':' before '}

124; \tester \production’857 \xp2115 0l-aa_qd_1401\prog - ““I\va:a\test‘h(EBZJ : warning C4244: =" | conversion from 'double’ to "int', pessible less of dats

13d: \tester\production’\357\xp2115_01-aa_qd_td01\progz - ElF \sourceltest. h(BE2) : warning C4244: conversion from 'double’ to "int’, possible loss of data

1>d: \tester\produetion\B57 \up2115_Ol-as_qd_t401iprog = @laihsowceltest. h(T18) : error C2059: syntax erver @ ' {

1>d: \tester\production\857\xp2115_01-aa_qt_t401prog - Bld\sourceltest. h(T18) : error C2143: syntax error : missing ‘i’ before ' {'

l)d \tester\production\857\xpZ115_01-aa_gd_t401iprog - H|& source\test h(718) : error C2143: syntax error : missing *:’ before '}’
tester\production\85T\xp2115_Dl-aa_gd_t401\prog - BlA\seurcetest. h(T19) : warning C4244: "=" © conversion frem ’ double’ to “imt’, possible Loss of data

1>:1 \tester\productiony857\xp2i15_01-aa_qd_t401iproz - E|Atsourcehtest. h(T64) : warning C424d: = : conversion from ' double’ to *int’, possible loss of data

14 \tester \production\85T\xp21 15 Dl-aa_gd_t401iprog - Bl \sourceltest cpp(548) : warning C4800: ~double’ @ forcing value to bool “trus or *false’ (performance warning)

17d: \tester\productioni857\xp2115_01-aa_qd_t401iprog = Elahsourcehtest. cpp(B43) : warning C4244 : conversion from ' dowble’ te “int’, possible loss of data

152: \tester \production'85T xp2115_01-aa_gd_t401\prog ~ E[F \source‘test. cpp(BSO) : warning C4244 comversion from ' deuble’ te "int’, possible loss of data

134 \tester \production'857 \xp2115_01-aa_qd_t4014prog ~ Sl sourcebtest. cpplB51) | warning C4244: conversion from ' dewble’ te "int', possible loss of dats

1>d: \tester \production\857'\%xp2115_01-aa_qd_t401\prog — Gl#source\test. cpp(ES2) © warning C4244 conversion from ' double’ te “int’, possible loss of dats

1)2: \tester \production'857 xp2115 Dl-aa_qd_t401%prog — B[# \seurceltest, cpp(BS3) : warning C4244: : conversion from ‘double’ te "int’, pessible loss of data

174: \tester\production’\857 \xp2115_01-aa_gd_t401\prog - Bl sourceltest. cpp(B39) © warning C4244 conversion frem ‘deuble’ te " fleat’, possible loss of data

124 \tester \producti on\85T\xp21 15 D1-sa_gd_t401\prog - BlaF\sourcaltest. cpp(@04) © warning £4204: conversion from * double’ to * float’, possible loss of data -
<

VC2005 FZmiFhy, A Erkes, BT VS2013 R VFAA7E — S AN VG 1Y
C++iEyk, {HAE VC2005 _EA LY, TFRERERF 5 R Tu Tt

WNESE ANCHEF S, Tk awg_pattern[0]=0.0.
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fdouble awg pattern[2000] = { 0.0 }; |

10t 1_foint = U,

int Trig_Point[SITEMUM] = { O }:

int sam;

double max_w = 0;

double min_w = 0;

max_v = [awgName—>GetMaxLimit ()) + max_overdrive;
min_v = (awzName—>GetMinLimit ()) - min_overdrive;

G0 00 69 60 66 GO0 OO OO 60 &% =
o e A St N R

CFG_FOVIE. Set (FI, 0, FOVI_SY, FOVI_IMA, RELAY_ON):

a0 delay me(1);
91 Iawg_pattern[ﬂ] = {00 I
92} Tam = WY S ML =tep) + 10/ step Imw

FITEVS ROUTR Sad (RW N RAVT SV ROUT AMA  BRT AT .

25. TEST Ul FEE 5118

TEST Ul A 4hR EAR RSS2 hfe, B2 EARRSCIHMR 2, AN AR 5 48 i
2P S DL T 223& B TestUN JA 2R 18 . 7 2023 L ARA Z BT AE, 774
BE—T &0 EARSUFER. #8189 AccoTEST->AccoTEST System ->
UpLoadToRemote.

PC » DATA(E) » AccoTest > AccolESTSystem 5 UplLoadToRemote v o

15] Unfinished 20221128 133457.ini
[5] Unfinished 20221129 161031_0ini
[5] Unfinished 20221128 161744.ini
{5] Unfinished 20230215 151328 0.
£5] Unfinished 20230215 170337.ini
{5] Unfinished 20230216 132552 Oini
{5] Unfinished 20230213 103211.ini
{5] Unfinished 20230219 103827 _Oiini
{5] Unfinished 20230219 125307.ini
£5] Unfinished 20230212 130632.ini
15] Unfinished 20230218 140730.ini
[5] Unfinished 20230219 141630_0iini
£5] Unfinished 20230218 143445.ini

1] Unfinished 20221129 133457 0.ini
L5] Unfinished 20221120 161034.ini
L] Unfinished 20221129 161744 0.ini
5] Unfinished 20230215 162558.ini
L] Unfinished 20230215 170337 Q.ini
L] Unfinished 20230216 132555 ini
L] Unfinished 20230219 10321 0.ini
L] Unfinished 20230219 112242.ini
] Unfinished 20230219 125307 0.ini
L] Unfinished 20230219 130634.ini
L] Unfinished 20230219 140730_0.ini
15] Unfinished 20230219 143306 ini
1] Unfinished 20230219 143445 0.ini

1] Unfinished 20221129 133452.ini
[5] Unfinished 20221129 161034 _Oini
£5] Unfinished 20230215 151326.ini
£5] Unfinished 20230215 162550.ini
£5] Unfinished 20230215 170338.ini
£5] Unfinished 20230216 132555_Dini
£5] Unfinished 20230219 103324.ini
£5] Unfinished 20230219 112242 Oiini
£5] Unfinished 20230219 125310.ini
£5] Unfinished 20230219 130634 _Oini
15] Unfinished 20230219 141627.ini
£5] Unfinished 20230219 143306 Qini
£3] Unfinished 20230219 143447.ini

] Unfinished 20221129 133459 O.ini
] Unfinished 20221129 161741.ini
5] Unfinished 20230215 151326 0.ini
] Unfinished 20230215 162601 ini
] Unfinished 20230215 170339 0.in
] Unfinished 20230219 103208.ini
5] Unfinished 20230219 103924 Qin
] Unfinished 20230219 112246.ini
& Unfinished 20230219 125310 0.ini
L] Unfinished 20230219 140727 ini
L] Unfinished 20230210 141627 0.in
5] Unfinished 20230219 143310.ini
] Unfinished 20230210 143448.ini

26. JBILEEI SR (AT ERAT G, DAL/ T [HIE 7

F SR Bl 22 e AN 4, gD 1 SR Bl 22 e e A Rl el

27.VS2013 j##E/F (Debugging) ZE/8

{] Unfinished 20221128 16103 .ini
[ Unfinished 20221129 161741 _Oiini
[ Unfinished 20230215 151328.ni
£ Unfinished 20230215 162601_Oiini
L] Unfinished 20230216 132552.ini
£] Unfinished 20230219 103208_Qiini
£] Unfinished 20230219 103927.ini
£ Unfinished 20230219 112246 ¢
£ Unfinished 20230219 13063 .ini
£ Unfinished 20230219 140727_Oiini
£ Unfinished 20230219 141630.ini
[ Unfinished 20230219 143310_Qiini

ini

FTHF T E A% TOOLS-> Options %1, .17 Debugging, #£%! Symbols Ihig, %
LR e B

(1) HUJH/213% Microsoft Symbol Servers;

(2) A7 Empty Symbol Cache, & Z5#5 %45
(3) #HJi VS2013.
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Options ? X
Search Options (Ctrl+E 2 Symbols
Tabs and Windows Symbol file (.pdb) locations: B X+
Task List

Web Browser [ Microsoft Symbol Servers | |
I Projects and Solutions
I Source Control
[ Text Editor
4 Debugging
General Cache symbols in this directory:
Edit and Continue Symbol cache directory ... Browse...

Just-In-Time

Output Window Load all symbols I Empt 1 sche I
Symbols
Performance Tools Automatically load symbols for:

I> Database Tools O All modules, unless excluded
P F# Tools Specify excluded modules
b HTML Designer ~

b Office Tools () Only specified modules

P Package Manager Specify modules

P SOL Server Tools

OK Cancel

28. N TFEGEEM A AfESBFAFAE-FEW I, & PGS JiE dil A
I 1

HE LR d SRR E, FESCOVAERIL, JFEE PGS Ml E KX
DLL 55ZFr T#2 DLL SO 4 2 5 — B FRAT T Hhii 4 (8200_220914_r &8300
200814 _rp4.0) 2 Hi ] New Project #:4E RS FRARHL(), Frihe Hi I New Project
(¥ TR A AR AR A R D ST I R . A R DR X AR P VS2013 it S
PRI B FAES T, FEC I SO T )T 3h B E I R
T

www.accotest.com

29



AlccOoTesT

IIREENERMRIGERAD

Beijing HuaFeng Test & Control Technology Co., Ltd.

| b4 HB225E65CP2AB_D0050_1M1S01A3 R V1 - Microsoft Visual Studio (Administrator)
FILE EDIT VIEW APA PROJECT BUILD DEBUG TEAM TOOLS TEST ANALYZE WINDOW
i Code PinPlanner B W - Q-

P Local Windows Debugger ~ = | Debug

testcpp + X

Build

X0q|oo}|

Rebuild
Clean
View >
7= External Dependencies Anaivre >
ili Barcode.lib ‘y
b ++ HB225E65CP2AB DO0S0 1M1S01A7 Project Only 4
b HPMtest.h Scope to This

b LotinforinputDLg.h

ili LotinforinputDlg.lib
b *+ NetWorkFun.cpp Profile Guided Optimization »
b NetWorkFun.h

B New Solution Explorer View

Build Dependencies »
ReadMe.txt
*+ StdAfx.cpp iga 4
b StdAfxh g> Class Wizard... Ctrl+Shift+X
P %+ testcpp # Manage NuGet Packages..
3 Setas StartUp Project
Debug »
< Source Control >
Solution Explorer EEETNS eI S @ FIIRUT X Cut Ctrl+X
Error List 5L Paste” Ctri+V
ropertes- oo
X Rename F2

Description
Unload Project

Rescan Solution

[CIRERY Output Find Symbol Results ¢> Open Folder in File Explorer
Properties

This item does not support previewing

Configuration:  Active(Debug) ~ Platform:  Active(Win32) v Configuration Manager...
{ ['» Commqn,P ertigs ., T . \HB225E65CP2AB_DO050_1H1S01A3 R V1.dll P
|| 4 Condgiim ropida ker Show Progress [<Edit. >
General Version | <inherit from parent or project defaults> ‘
| Debuggi Enable Incremental Linking Yes (/INCREMENTAL)
VC++ Digectories Suppress Startup Banner Yes (/NOLOGO)
| b C/C++ Ignore Import Library No E
| b Linker Register Output No 4}§\E_FhL Ay
|| » Manifest Tool Per-user Redirection S\ﬁtj}:%él i*ﬁi&?ﬂi&ﬂ\ﬁlﬁ
b XML Document Generator Additional Library Directories “\AccoTes! SngCROSS\IIB:C:\Ac(oTest\STSBZOOCROSS\!NCLude:%(Additiona
b Browse Information Link Library Dependencies Yes
b Build Events Use Library Dependency Inputs No
b Custom Build Step Link Status
b Code Analysis Prevent DIl Binding

Treat Linker Warning As Errors
Force File Output

Create Hot Patchable Image
Specify Section Attributes

# Tt =2
Output File 6. EﬁZE E E?ﬁ%#&}%
The /OUT option overrides the default name and location of the program that the Iink%

by
L BGH RZF(A)

29. Control JRE] & & StationA JEEIE#TH TEST Ul JRE, B “KE52#
BT, BER! 7 HEHE

AR e B IER, AR IR IRA B B 4G Fail, PR5E2 PCI R
W, WERENE, 5 YIENARST L TE AFRY 360 724 Ll
TARTFRAEEE, B EEE AT HART
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30. VS 1R AEFT I BRIk AL HIFE/F = H BEFR#S: The build tools for v140 (Platform

Toolset ='v140") cannot be found. ...... "

wtn: MERRA VS (VS2015/VS2022) F4ikfe)y, T/ % vS2013 H1#
H, fRkgad: TH->EE-SECEEE->F N, L2076 T HEEH v140 8N
v120 (Visual Studio 2013(v120)).

FOVI_Example Property Pages ? X
Configuration:  Active(Debug) v Platform:  Active(Win32) ~  Configuration Manager...
4 Common Properties v~ General
References Output Directory of
4 Configuration Properties Intermediate Directory Adebug\
General Target Name $(ProjectName)
Debugging Target Extension dll
VC++ Directories Extensions to Delete on Clean *.cdf;*.cache;*.obj;*.ilk;*.resources;* tIb;*.tli;*.tlh;*.tmp;*
b C/C++ Build Log File $(IntDin$(MSBuildProjectName).log
b Linker e = visual Studio 2013 (v120)
I Manifest Tool Enable Managed Incrementalj¥E i
> XML Document Generator “ Project Defaults Visual Studio 2013 - Windows XP (v120 xp)
> Browse Information Configuration Type <inherit from parent or project defaults>
1> Build Events Use of MFC Use Standard Windows Libraries
I Custom Build Step Character Set Use Multi-Byte Character Set
> Code Analysis Common Language Runtime No Common Language Runtime Support

Whole Program Optimization No Whole Program Optimization
Windows Store App Support No

Platform Toolset
Specifies the toolset used for building the current configuration; If not set, the defau...

HiE il ZFE(A)
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31. STS8200 #t/# 220419 r RL_L/RAF & PGS #Af#87 “Length cannot exceed
501~

1% = K
Name: I!0_5V5002_DA3R3(TP3206)_P(A)_SFSS200_451te_(!.PZ) Update PGS Name L
Path: [C:\sers\user|Desktop o || f
SrcName ‘ DstName ’ |
1 | FT_GD1920 SY5002 Df F——————72 pAsr3TP3206) P(A) 5T5... |

‘8‘ Length cannot exceed 50!
oK

OK Cancel

STS8200 1.2.0.0.230925 r

WTE, TREXHELEIRES S VS ks, Kk STS8200 HifF 220419 r K
PL_EPRAS T PGS KB T BRI

AR ERKK ERRE ARy SRR +2* TR AR +62,  fik

A AP VLA S B R B BR AR FE G N B 2 S B0 VS G 1)

s\Visual Studio 2013\Projects\ConscleApplicationl

1.d11", FLEEHETH eoe 32#f,
el3z.dl1”, FLEEIRBITIF roB ¥,

(1) %# DEBUG — Options and Settings...
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IDEBUG ITEAM TOOLS TEST

ANALYZE WINDO

v

Ge

Windows

Graphics

Start Debugging

Start Without Debugging
Attach to Process...

Debug Installed App Package...
Exceptions...

Performance and Diagnostics
Step Into

Step Over

Toggle Breakpoint

New Breakpoint

Delete All Breakpoints

Options and Settings...

>

FOVI_Example Properties...

ES
Ctrl+F5

Ctrl+Alt+E
Alt+F2

F11

F10

F9

Ctrl+Shift+F9

(2) 7E General #/2)i% “Enable source server support”

Options

Search Options (Ctrl+E)

P General

Environment

Source Control
Text Editor
Debugging
General
Edit and Continue
Just-In-Time
Output Window
Symbols
Performance Tools
Database Tools
F# Tools
HTML Designer
Office Tools
Package Manager
Text Templating

Avvvow

FPvevvvovvvosw

Projects and Solutions

Wah Parfnrmanca Tast Tanls

50 e qi1agnost

) Allow source server for partial tru

) Show all members for non-user objects in variables windows (Vis
@ Warn if no user code on launch (Managed only)

() Enable .NET Framework source stepping

@ Step over properties and operators (Managed only)

@ Enable property evaluation and other implicit function calls

pn objects in variables windows

sages to the Output window
st assemblies (Managed only)

O Always run d source server ds without prompt

() Highlight entire source line for breakpoints and current statement
@ Require source files to exactly match the original version

(O Redirect all Output Window text to the Immediate Window

() Show raw structure of objects in variables windows

@ Suppress JIT optimization on module load (Managed only)

(3) i%&#¢ Symbols, 2)iE “Microsoft Symbol Severs”

Options
Search Options (Ctrl+E)

Environment

Source Control
Text Editor
Debugging
General
Edit and Continue
Just-In-Time

Qutput Window

AT T TT

Projects and Solutions I

£ Symbols
Symbol file (.pdb) locations:

A X r ¢

Symbol cache directory

Cache symbols in this directory:

Browse...

Symbols
lormance 100ls
Database Tools
F# Tools
HTML Designer
Office Tools
Package Manager
Text Templating
Weh Darf Te

FPvvv v v

Load all symbols

i | modul

) Only specified modules

ify modul

<t Trnle

Automatically load symbols for:
© All modules, unless excluded

Empty Symbol Cache

e
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